# Contents

Welcome to BreakTweaker

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>KEY FEATURES</td>
<td>5</td>
</tr>
<tr>
<td>What is BreakTweaker?</td>
<td>6</td>
</tr>
<tr>
<td>The Sequencer</td>
<td>6</td>
</tr>
<tr>
<td>The Generator</td>
<td>6</td>
</tr>
<tr>
<td>MicroEdit Engine</td>
<td>6</td>
</tr>
<tr>
<td>The Factory Library</td>
<td>7</td>
</tr>
</tbody>
</table>

Authorization

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Launching the Authorization Wizard</td>
<td>8</td>
</tr>
<tr>
<td>Trial vs. Demo Mode</td>
<td>9</td>
</tr>
<tr>
<td>Authorizing Your Copy of BreakTweaker Online</td>
<td>9</td>
</tr>
<tr>
<td>Authorizing Your Copy of BreakTweaker Offline</td>
<td>9</td>
</tr>
</tbody>
</table>

Controlling BreakTweaker in Your DAW

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Host Sync</td>
<td>11</td>
</tr>
<tr>
<td>Playing Patterns</td>
<td>11</td>
</tr>
<tr>
<td>Playing Track Sounds (Sampler Mode)</td>
<td>13</td>
</tr>
<tr>
<td>Previewing Your Sequence Without MIDI</td>
<td>13</td>
</tr>
</tbody>
</table>

Preset Management

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Presets</td>
<td>14</td>
</tr>
<tr>
<td>Preset Manager</td>
<td>15</td>
</tr>
<tr>
<td>Saving a Preset</td>
<td>15</td>
</tr>
<tr>
<td>Starting a New Preset</td>
<td>15</td>
</tr>
<tr>
<td>Exporting Presets</td>
<td>15</td>
</tr>
<tr>
<td>Importing Presets</td>
<td>16</td>
</tr>
</tbody>
</table>
### Generator Presets
- Clearing All Generators in a Track
- Deleting Presets and Empty Categories

### Mixing Your Tracks
- Gain
- Pan
- Mute and Solo
- Level Meter
- Intensity & Master Gain

### Sequencer
- Navigating the Sequencer
- Sequencer Overview
- The Sequencer Ruler
- Working with Steps
  - New Step
  - Delete Step
  - Choke Step
  - Copying and Pasting a Step
  - Selecting Steps
  - Copying a Track
  - Clearing a Track
- Patterns
  - Copying a Pattern
  - Pasting a Pattern
  - Clearing a Pattern
- Track Length
- Track Playback Speed

### Generators
- Sample Generator
  - Loading a Sample
  - Discover
  - Waveform Trim Points and Zooming
  - Playback and Looping
  - Pitch
- Synth Generator
  - Wavetable Shape
  - Pitch
  - Synthesis Types
  - Filter
Generator Distortion ........................................ 33
Generator Mixing (Gain & Pan) ............................. 33
Modulating Generator Lane Parameters ..................... 34
    The Modulation Knob .................................. 34
    AHDSR Envelope ...................................... 36
    Low Frequency Oscillator (LFO) ....................... 39
    Mixing Modulators .................................... 40
Linking Envelopes and LFOs Across Generator Lanes ........ 42
Previewing Your Track’s Sound ............................. 43
    Generator Solo ........................................ 43
Generator Presets ........................................... 43

MicroEdit Engine
Applying Microedits ......................................... 44
    Microedit Modes ....................................... 45
    Retrigger ................................................ 45
    Microedit Slope ........................................ 45
    Musical Shapes ........................................ 46
    Microedit Gate ......................................... 47
    Coarse Pitch Offset ................................... 47
    Microedit Step Fades and Effects ....................... 47
        Step Fade .......................................... 48
        Step Effect ........................................ 48

Multi-channel Output in your DAW
Ableton Live .................................................. 50
Pro Tools 10 .................................................. 50
Pro Tools 11 .................................................. 50
Apple Logic Pro X ........................................... 51
ImageLine FL Studio ......................................... 51
Steinberg Nuendo/Cubase ................................... 51
Digital Performer ............................................ 52
Cockos Reaper ............................................... 52
SONAR X2/X3 .................................................. 52
Welcome to BreakTweaker

Make beats you’ve never heard before. Built on a futuristic MicroEdit engine, BreakTweaker turns everything you know about rhythm on its head.

**Designed by BT and developed by iZotope, BreakTweaker is not just a drum machine:** it’s a drum sculpting and beat sequencing machine that blurs the line between rhythm and melody. Give your beats an evolving depth that gets better the longer they play. Use rhythmic slicing to drive everything from pitched melodic lines to sweeping rhythmic concoctions. Top it all off with the best drum sample library in existence, curated by BT, iZotope, and top producers today. Explore a new era of rhythmic possibilities with this forward-thinking and forward-sounding instrument.

**KEY FEATURES**

- **Manipulate audio at a molecular level:** Reinvent any beat by controlling pitch, rhythm, and texture at the most finite resolution on the market.

- **Experiment with stunning content:** Explore a full range of presets, drum samples, and wavetables designed by today’s top musicians and DJs, including BT.

- **Invent completely original rhythms:** Create complex polyrhythmic lines with unique isorhythm and playback speed settings.

- **Craft the perfect drum sound:** Blend samples and robust synthesizer features to create drums sounds that are “best of both worlds” sounds using BreakTweaker’s Generators.

- **Take control of your beats:** Easily trigger and sequence complex patterns and samples using any MIDI controller.
WHAT IS BREAKTWEAKER?

BreakTweaker is powered by three distinct modules, the Sequencer, the Generator, and the MicroEdit Engine, it’s a wildly creative rhythmic instrument that can be used with any DAW and MIDI controller. For instant gratification, get started with the diverse presets and content in the Factory Library, a showcase of BreakTweaker’s breadth and sonic capabilities. When you want to get deeper, break new sonic ground with BreakTweaker’s paradise of tweaky controls and settings.

The Sequencer

Assemble pattern-based beats in the Sequencer, which features six tracks for layering your sounds. The Sequencer can store up to 24 different step patterns, launchable and retriggerable via MIDI for on-the-fly remixing. Design beats that evolve over time with BreakTweaker’s advanced isorhythmic step sequencing, which makes it possible for each track to have a unique tempo and step length.

The Generator

Sculpt new drum sounds and textures with the Generator. This powerful drum synthesis module defines the sounds for each Sequencer track. The Generator supports morphing wavetable synthesis or one-shot sample loading, polished off with dual-stage distortions and vintage-modeled filters. Four LFOs with unique wavetable shapes, and four Envelopes allow vast modulation possibilities for almost every single Generator parameter. As a bonus, every Sequencer track supports up to three Generators for developing even deeper sonic complexity.

MicroEdit Engine

Once you’ve perfected the ultimate set of drum sounds and sequenced your patterns, it’s time for a whole new method of sound design. Enter the MicroEdit Engine. A “microedit” is the division of a single step within your pattern into potentially thousands of slices. These slices can then be contoured and shaped to create harmonic,
pitched, and rhythmic effects, resulting in new textures that add that extra spice to an evolving beat. By pushing the limits of the brain’s ability to perceive sound, the MicroEdit Engine blurs the line between rhythm and pitch, inspiring beats you’ve never heard before.

### The Factory Library

Bringing sounds, patterns, and microedits together into mind-boggling beats, the BreakTweaker Factory Library comes with over 80 global presets that are ready to kickstart your next project. The Factory Library also features over 2 GB of royalty-free sample content designed by electronic production pros. Specializing in a wide variety of percussive sounds, sample categories range from studio essentials like “Kick” and “Snare” to intriguing possibilities like “Glitch” and “Film”.

<table>
<thead>
<tr>
<th>Kick</th>
<th>A8-Kick 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acoustic</td>
<td>A8-Kick Glk</td>
</tr>
<tr>
<td>Basics</td>
<td>A8-Kick Hes</td>
</tr>
<tr>
<td>Dubstep</td>
<td>A8-Kick Hes</td>
</tr>
<tr>
<td>Electro</td>
<td>A8-Kick Hes</td>
</tr>
<tr>
<td>Hip Hop</td>
<td>A8-Kick Mel</td>
</tr>
<tr>
<td>Minimal</td>
<td>A8-Kick Mel</td>
</tr>
<tr>
<td>Trance</td>
<td>A8-Kick Mel</td>
</tr>
<tr>
<td>Vintage</td>
<td>A8-Kick Mel</td>
</tr>
</tbody>
</table>

PLUS: Expand your sonic palette with BreakTweaker’s add-on Expansion libraries, suited to a variety of production styles. Experience analog punch with Vintage Machines, rhythmic tension and release with Cinematic Textures, and industry-defining percussion with Kicks & Snares by Beatport Sounds.
Authorization

Each purchased copy of BreakTweaker contains a unique serial. After downloading BreakTweaker directly from iZotope or another re-seller the serial number will be e-mailed along with the link to download the product. The serial number should resemble: SN-BREAKTWEAKER-XXXX-XXXX-XXXX-XXXX

LAUNCHING THE AUTHORIZATION WIZARD

The first time you open BreakTweaker, the Authorization Wizard will appear. You can choose to either authorize BreakTweaker or use it in Trial mode for evaluation purposes. Please use your supplied BreakTweaker serial number to fully authorize your product.
TRIAL VS. DEMO MODE

For the first 10 days after the first instantiation, BreakTweaker will run in Trial mode, which offers full functionality. After 10 days, BreakTweaker will revert to Demo mode. In Demo mode, BreakTweaker will periodically mute audio output.

AUTHORIZING YOUR COPY OF BREAKTWEAKER ONLINE

After opening BreakTweaker and launching the Authorization Wizard, the following steps will complete the authorization process online:

1. First, click on ‘Authorize’.
2. Next, enter the serial number emailed to you. It should look like this: SN-BREAKTWEAKER-XXXX-XXXX-XXXX-XXXX
3. You must also enter your name and a valid e-mail address. Make note of the e-mail address you use to authorize your license. Your license and iZotope account will be linked directly to this e-mail address. Note: Clicking the ‘Advanced’ button reveals a set of options that allow you to store your BreakTweaker authorization on a portable hard drive or flash drive. Click here for more information on these options.
4. When you have confirmed that your serial number and e-mail information is accurate, click once more on ‘Authorize’.
5. Lastly, click on ‘Submit’ in order to send your authorization message to the iZotope servers. If the authorization is accepted, click on the ‘Finish’ button to complete the authorization.

AUTHORIZING YOUR COPY OF BREAKTWEAKER OFFLINE

Some customers choose to keep their audio workstations offline, and a simple offline authorization option has been included. After opening BreakTweaker and launching the Authorization Wizard, the following steps will complete the authorization process offline:

1. When first prompted to authorize BreakTweaker, click on ‘Authorize’
2. Next, click on the option for ‘Offline Authorization’ at the bottom of the authorization window, select “Authorize with iZotope challenge/response” and click next.
3. You will be given a unique Challenge Code that is specific to your computer only. Write down or make a copy of the exact Challenge Code. It will look like this:
IZ-BREAKTWEAKER-XXXXXXXX-XXXX-XXXX

4. Next, using a system with internet access, login to your customer account at the iZotope website: http://www.izotope.com/store/account.asp

5. Click the ‘Activate Software with a Serial Number’ button, enter your full serial number and click ‘Submit’.

6. Select the ‘Challenge/Response’ option and click on ‘Submit’.

7. Read the License Agreement and click “Agree” if you find it agreeable.


9. After submitting your Challenge Code, you will receive a unique Response Code. The response code will look like this:
IZ-BREAKTWEAKER-XXXX-XXXX-XXXX

10. Write this response code or save a text file with the response code onto a flash drive.

11. Type or paste the Response Code into the text field of Step 3 in the Offline Authorization window.

12. Click ‘Next’ to authorize BreakTweaker.

13. You should now receive a message that your authorization has been successful and may click Finish to begin using BreakTweaker.
Controlling BreakTweaker in Your DAW

BreakTweaker is a software instrument. In order to get BreakTweaker to start playing a pattern or an individual track sound you must instantiate BreakTweaker on an instrument track. Input MIDI notes from your DAW’s piano roll or an external MIDI controller will either play back one of the 24 patterns or play a track’s Generator.

HOST SYNC

By default, BreakTweaker’s patterns play at the same tempo as your host. Uncheck the Tempo Sync check box if you wish to play your sequences at a tempo that is different than your host.

PLAYING PATTERNS

There are 24 available patterns in BreakTweaker. Each pattern is assigned to a MIDI note from C2 through B3. Playing one of these notes into BreakTweaker will cause the pattern associated with that MIDI note to start playing.
**Sequential Notes**

If MIDI notes do not overlap then the BreakTweaker playhead will reset to the beginning with each note on received.

**Legato Notes**

If MIDI notes overlap, then BreakTweaker’s playhead does not reset to the beginning.

The next pattern will start playing from where the previous pattern left off. This allows you to play the beginning of one pattern into the middle of another pattern.

If you want legato notes to reset the playhead to the beginning of the pattern then check the “Always Retrigger” box.

**Latch Mode**

With Latch Mode turned on MIDI notes C2 through B3 will toggle playback of patterns 1 through 24, respectively. For example, pressing and releasing note C2 once will start the playback of pattern 1. Pattern 1 will continue playing until C2 is pressed again. Pressing another pattern’s MIDI note while a pattern is playing will change to and start playing that pattern.
In the screenshot on the previous page, the following will happen:

Bar 1: Start pattern 1
Bar 2: Start pattern 2
Bar 3: Start pattern 1
Bar 4: Stop pattern 1

PLAYING TRACK SOUNDS (SAMPLER MODE)

MIDI notes C1 through F1 will trigger the sounds of tracks 1 through 6, respectively. BreakTweaker will react to the MIDI note’s velocity by altering the volume of the sound.

In most digital audio workstations (DAWs) BreakTweaker will react to MIDI notes C2 through B3 to trigger patterns and C1 through F1 to play BreakTweaker as a sampler. However some DAWs handle MIDI differently and the range of MIDI notes is up by an octave or two:

In Cockos Reaper BreakTweaker responds to MIDI notes C3 through B4 to trigger patterns and sampler mode uses notes C2 to F2.

In Sony Acid Pro, Image Line FL Studio, and Cakewalk Sonar BreakTweaker responds to MIDI notes C4 through B5 to trigger patterns and sampler mode uses notes C3 to F3.

PREVIEWING YOUR SEQUENCE WITHOUT MIDI

To preview your pattern without having to input MIDI into BreakTweaker hit the preview play button at the bottom left of the BreakTweaker screen.
Preset Management

There are two kinds of presets in BreakTweaker: Global Presets and Generator Presets. The Global Presets will save everything in the plug-in including the sound of each track and all 24 patterns slots. Generator presets save the state of the sound of a track so it is easy to recall a particular drum sound for use in multiple Global Presets.

GLOBAL PRESETS

BreakTweaker’s presets store both the sequencer patterns and generator sounds. The presets are organized into categories that you can browse via the Preset Browser.
**Preset Manager**

To open the Preset Manager click the black area where the preset name is displayed. BreakTweaker’s presets are organized into categories. Click on a category on the left and the presets in that category will be listed in the column to the right. Click on a preset to load it.

**Load Kit Only**

If you wish to preserve the sequence you’ve built in BreakTweaker and just load the sounds from another preset click the “Load Kit Only” checkbox. This allows you to play your pattern sequence and audition the variety of sounds in each of the presets. The preset name will change to the name of the preset from which the kit comes from. The color of the preset changes from white to green to signify that only the kit from the preset is loaded.

**Saving a Preset**

Once you have selected a preset from the list, you may choose to change the sequence or generator sounds. When you change any of the original settings within a preset you will see an asterisk* added to the beginning of the preset’s name. If you want to keep these changes you need to Save a new preset or overwrite the existing preset.

To save a preset click the “Save” button. If you are saving a modified preset then the name and category of that preset will be automatically set. If you click save, a dialog will ask if you wish to overwrite the preset with the new version. If you do not wish to overwrite the preset then change the name of the preset before saving.

**Starting a New Preset**

To start fresh and clear out all sequence and generator settings click the “New” button next to the Preset “Save” button. BreakTweaker will now be in its default state.

**Exporting Presets**

If you wish to share a preset with someone on another computer you can export the preset. The exported preset contains all the sequence information as well as any samples used in the generators. To export a preset open the Preset Manager, click on the the preset you wish to export and click the Export button at the bottom of the manager window. You will be prompted to save the file to your local file system.
Importing Presets

To import a preset open the Preset Manager and click the Import button at the bottom of the manager window. You will be prompted to choose the preset via a file open dialog box. Choose the preset and click open. The imported preset will be found in the “Imported” category.

GENERATOR PRESETS

There are a lot of settings that go into creating the sound of a track. To save time and effort BreakTweaker has Generator Presets. With Generator Presets you are able to save the state of the three Generators that make up a track. So once you’ve sculpted the perfect bangin’ kick drum sound, you can use it again and again by saving it into a Generator Preset. This preset can be applied to any track to recall that kick drum sound.

Generator Preset Manager

To open the Generator Preset Browser click the icon to the left of the Track Speed, Gain, and Pan parameters. On the left hand side are a list of categories. Click a category to view the Generator Presets stored within that category. Click the plus button to create new, custom categories.

Saving a Generator Preset

To save a Generator Preset open the Generator Preset Manager, choose a category where you wish to save the preset and then click the Save button. A dialog will prompt you to name the preset.
Clearing All Generators in a Track

To start clear out a track’s Generators click the New button. This will set all three Generators on that track to their default, empty state.

Deleting Presets and Empty Categories

The Delete button has two functions. If a Generator preset is selected it will remove that preset from your computer. If you select an empty category and click the Delete button this will remove that category from your computer. If a category contains presets the Delete button will not function.
Mixing Your Tracks

Each track has basic mixing functionality including Gain, Pan, Mute, and Solo.

**GAIN**

Gain adjusts the overall volume of the track’s combined Generator sounds.
PAN

The pan knob adjusts the track’s combined Generator sound location within the stereo field.

MUTE AND SOLO

Each track has a mute and solo button. Clicking the mute button silences that track. The solo button will silence all the other tracks and only allow the soloed track to be heard.

Alt/Option-clicking on a solo button will reset all other track solo buttons to be turned off and only the Alt/Option-clicked track will be soloed.

LEVEL METER

The level meter shows you an accurate representation of the amplitude of your signal for each individual track. There is also a master level meter next to the master gain knob. Each level meter will indicate your signal is clipping with clip light indicators. To reset these clip lights, left-click once on the meter.

INTENSITY & MASTER GAIN

Sometimes your mix needs that slight touch to get all the tracks to “glue” together. That’s where the Intensity knob comes in. At its core is a compressor/limiter that will smooth out your mix and give it that extra boost of loudness to have your BreakTweaker rhythms cut through the mix.

Before BreakTweaker’s audio is output to your host, there is one last gain stage. The Master Gain allows you to modify the loudness level of your mixed tracks.
Sequencer

The sequencer is where you program the order in which each track’s generator sounds play. Whether it is drums, bass, or abstract noises, BreakTweaker won’t make any sound until you tell it to play some sequenced notes.

NAVIGATING THE SEQUENCER

Drag the sequencer overview or sequencer ruler to scroll left and right in the sequence.
Sequencer Overview

Above the track sequencer is the sequencer overview. Drag the blue rectangle left and right to move around in the sequencer. Hovering over the sequencer overview and using the mouse scroll wheel will also move you left and right in the sequencer. Jump to another position in the sequencer by clicking in an area of the Sequencer Overview that is not currently being viewed. Double-clicking or option/alt-clicking on the Sequencer Overview will reset the view to the beginning of the sequencer.

The Sequencer Ruler

The sequencer ruler shows you the bars and beats of your sequence. Click and drag the ruler to scroll left and right. You may also scroll left and right by hovering your mouse over the ruler and using your mouse’s scroll wheel. Double-clicking or option/alt-clicking on the ruler will reset the view to the beginning of the sequencer.

To work with other time signatures, right-click the ruler to change the time signature grid.

WORKING WITH STEPS

New Step

Click on an empty step to create a new step. Clicking and dragging to the right will make a step that is longer than one step. You must do this to make a step with a long sustained sound.
Delete Step

Double-click a step or right-click and choose Delete. With Keyboard Support set to “Full” in the plug-in options menu the Backspace key should also delete a step.

Note: Some hosts do not allow plug-ins to make use of the backspace key so you may not be able to delete a step with the backspace key in your Digital Audio Workstation.

Choke Step

To choke a step right-click on an active step and choose “choke step”. The color of the step will turn dark as pictured above.

A choked step does not make any sound. Its role is to immediately silence the previous, adjacent note by stopping the Release portion of an applied AHDSR envelope. This is a similar effect to a drummer hitting a cymbal and immediately grabbing the cymbal to stop it from ringing out and decaying naturally. Choked steps should follow immediately after an active step in order to choke that previous step. The previous step will need to have an AHDSR envelope applied to the gain and/or filter with a release that is long enough to hear in contrast to the immediate silence of a choked step.

Copying and Pasting a Step

Right-click on an active step and choose Copy from the contextual menu. Right-click on another spot in any track’s sequencer and choose Paste from the contextual menu to paste the step. The copied step will include any microedit information along with the step length. A pasted step can replace any active steps that overlap the spot where the step was pasted. If a shorter step is pasted in the middle of a longer step that longer step will be shortened from the right, preserving the left-hand portion of the longer step.

Steps are copied to the system clipboard. Copied steps can not only be copied from one track to another, but they can also be copied from one instance of BreakTweaker to another.

Selecting Steps

BreakTweaker lets you select multiple steps in one track in order to manipulate those selected tracks. A selection of steps can be copied, deleted, choked, moved, and you can adjust velocity. Note: You cannot select steps between tracks. Only steps on one track can be selected at a time.
To select multiple steps in a row, click on one end of the group of steps and then shift-click at the other end of the group of steps you wish to select. This will select all the steps in between these two steps.

Command/CTRL-click on each step to select a non-contiguous group of steps (e.g. every other step or every step that falls on the first beat of a bar).

Right-click on any step of a track and choose Select All from the contextual menu to select every step in the track sequence.

**Copying a Track**

Right-clicking on a track’s step sequence and choosing Track > Copy will copy the entire track’s steps. Right-clicking on another track’s step sequence and choosing Track > Paste will then replace that track’s sequence with the copied sequence.

**Clearing a Track**

To remove all the steps from a single track’s sequence right-click on that track and choose Track > Clear from the contextual menu.

**PATTERNS**

The collection of all six tracks is a pattern. There are several things you can do to manipulate all six tracks at once. You may copy the whole pattern, paste the whole pattern, or clear the whole pattern.

**Copying a Pattern**

To copy a pattern, right-click on any track and choose Pattern > Copy Pattern from the contextual menu. The copied pattern can then be pasted into another pattern slot or into another instance of BreakTweaker.

**Pasting a Pattern**

To paste a copied pattern, switch to another pattern slot and right-click on any of the track sequence lanes. Choose Pattern > Paste Pattern from the contextual menu. Since the patterns are copied to the system clipboard you may paste these patterns into other instances of BreakTweaker.

**Clearing a Pattern**

To delete all the sequence information on every track of a pattern, right-click on a track and choose Pattern > Clear Pattern.
**TRACK LENGTH**

BreakTweaker allows you to explore complex rhythms and polyrhythms by having each track run at its own length. This could be something simple like having one track be one bar long and another be two bars long or it could be crazy like having one track play for three beats and another for two bars.

To alter the length of a track’s length drag the track length handle left or right to shorten or lengthen the loop. You may select multiple track length handles by command/ctrl-clicking individual handles or shift-clicking to select a range of handles at once.

**TRACK PLAYBACK SPEED**

Each track can play at its own speed based on the tempo of BreakTweaker. Tracks can play at normal tempo (1x), one-third tempo (1/3x), half tempo (1/2x), two-thirds tempo (2/3x), one and one-half tempo (3/2x), double tempo (2x), or triple tempo (3x).

Switching track speeds while BreakTweaker is playing will cause the tracks to fall out of sync with each other. It is best to stop BreakTweaker’s transport, change the track’s speed, and then start BreakTweaker playing again.
Generators

The source of BreakTweaker’s sounds are its Generators. Each track has three Generator Lanes. For each Generator Lane you have the choice of a sample player or a dual oscillator synth. Within each Generator Lane there are distortion effects and a choice of filters to shape the sound. Each Generator Lane also contains four envelopes and four low frequency oscillators (LFO) for modulating all of the parameters found in each Generator Lane. By mixing samples and synthesized sound together, along with copious amounts of LFO and Envelope modulation, the sound design possibilities are endless!
To access a track’s Generator page click on the track’s button. You will be presented with one Generator that is open and the other two lanes will be collapsed. To view another Generator Lane click the button. To change the Generator Lane’s type, click the drop down menu to choose one of the two Generator type options.

**SAMPLE GENERATOR**

The Sample Generator plays WAV and AIFF audio files. BreakTweaker has a library of audio samples to choose from or you can load your own external samples. The Sample Generator module has control over sample trim points, looping and playback directions, pitch, gain stages, and panning.

**Loading a Sample**

BreakTweaker comes with a library of samples that can be accessed through the sample browser. The down and up arrows attached to the sample browser will choose the next and previous sample within the same folder.

You may load in a WAV or AIFF sample from your own collection of files by either dragging and dropping a file to the Sample generator or by clicking the Load button. The Load button presents you with a system dialog window to browse and select a sample. The down and up arrows will let you quickly select the next or previous samples within the folder that contains the loaded sample.

*BreakTweaker’s Sample Generator supports mono and stereo WAV and AIFF files of any sample rate or bit depth.*
Discover

The Discover button will suggest other factory-loaded sounds that are similar. Discover requires an Internet connection in order to function. This is a novel new way to narrow down your search for just the right drum sound. This feature will only work on the factory-loaded samples. Discover cannot currently search for samples based on a user’s own sample collection.

To use the Discover button:

1. Load a factory-installed sample into a Sample Generator
2. Click the Discover button
3. You will be presented with a list of ten samples that sound similar to the selected sample

The first time you click the Discover button you will be presented with a screen to authorize the use of this feature.

Waveform Trim Points and Zooming

The Sample Generator features a zoomable waveform view. To zoom, either click the zoom in/out buttons or use your mouse’s scroll wheel while the mouse cursor is hovering over the waveform.

When a new sample is loaded into the Sample Generator the entire sample is selected. If you wish to only play a portion of the sample click and drag the start and end trim points. Alternatively, you may enter in an exact sample value for the trim points via the text input boxes.
Playback and Looping

The Sample Generator has four sample playback modes: Forward, Reverse, Forward-Reverse, and Reverse-Forward. With looping turned off Forward and Reverse modes will play the sample once from the start and end trim points. The Forward-Reverse and Reverse-Forward modes will play the sample once in each direction. For example, Forward-Reverse will play the sample forward and then immediately in reverse.

With looping turned on the sample will play continuously between the trim points. Forward and Reverse modes will loop in their respective directions. The Forward-Reverse and Reverse-Forward play in each direction bouncing back and forth.

Crossfade

Next to the Loop button is the crossfade value. The crossfade parameter is the number of samples used to blend between the each end of sample selection. Diagonal lines are drawn at the trim points to illustrate what is being used for the cross fades.

Pitch

The Sample sample can be tuned up or down with the Coarse Pitch and Fine Pitch knobs. Coarse Pitch can slow down the sample by up to 50% (-12 semitones) or speed up the sample by up to 200% (+12 semitones). The Fine Pitch will change the pitch by +/- 50 cents. Both of these parameters can be modulated by envelopes or LFOs.
SYNTH GENERATOR

The Synth Generator is a dual wavetable synthesizer. Each wavetable oscillator module has individual control over its wavetable shape, pitch, gain stages, and panning.

Wavetable Shape

At the heart of the Wavetable Synthesizer Generator are the two wavetable oscillators. Wavetable oscillators are digitally-sampled audio waveforms that can represent simple to complex sounds.
Various wavetable sounds are included with BreakTweaker. A wavetable is loaded via the wavetable menu. To reveal the wavetable browser menu click on the blue box that contains the wavetable name (above pictured as 4-RD Spectral/Cycles). The wavetables included with BreakTweaker are actually composed of two or more wavetable shapes. The Shape slider controls the interpolation between each shape in the wavetable. Like the rest of the parameters in the wavetable oscillator the Shape slider can be modulated by LFO or Envelope to add movement to the oscillator’s sound.

**Pitch**

Each wavetable oscillator’s pitch is set by the Coarse Pitch knob. This knob by default is set to display its value as a note/octave value. By right-clicking the Coarse Pitch knob you can change the displayed value to hertz (Hz).

The Fine Pitch knob can detune the pitch set in the Coarse Pitch knob by 50 cents up or down.

**Synthesis Types**

The two wavetable oscillators can interact with each other via Additive, Frequency Modulation (FM), Amplitude Modulation (AM), or Ring Modulation. When the synth is in the “Off” (default) mode only oscillator 1 will sound.
Additive [+]

Additive Synthesis mode will simply mix the Oscillator 1 and Oscillator 2 together. Oftentimes Additive Synthesis is used to mix two simpler waveforms such as two sine waves of different frequencies into a more complex sound.

Ring Modulation [X]

Ring Modulation tends to lend a metallic and often times dissonant sound. Oscillator 1, known as the Carrier, is multiplied by Oscillator 2, known as the Modulator. The resulting output from multiplying the two waveforms is that the Carrier is no longer audible but there are two new frequencies heard that center around where the Carrier signal was. These two new frequencies are above and below the Carrier frequency by the frequency value of the Modulator signal. For example if the Carrier frequency is 440 Hz and the Modulator frequency is 40 Hz then the resulting frequencies that you will hear are 400 Hz and 480 Hz.

Amplitude Modulation [AM]

Amplitude Modulation will change the loudness (i.e. amplitude) of the Carrier according to the Modulator’s unipolar wave. The sound of AM Synthesis is similar to Ring Modulation except the Carrier is audible along with the two additional frequencies.

Frequency Modulation [FM]

In FM Synthesis the frequency of the Carrier wave is modulated by the Modulator’s wave. It is best observed when using simple waveforms such as a sine wave for both the Carrier and Modulator. Start with the gain of the Modulator turned all the way down. Start playing a sequence of notes to hear the Carrier by itself. Next start turning up the gain of the Modulator. You will hear the Carrier start to sound distorted and gritty.
Each Generator can have an instance of one of eight filters. There are three distinct flavors of filters in BreakTweaker: New York, Japan, and Brick Wall.

**New York:** Based on a famous analog filter design originally developed in upstate New York in the 1960s. There are low pass, band pass, and high pass versions of this filter.

**Tokyo:** Based on a famous Japanese analog filter designed in Tokyo in the 1970s. There are low pass and high pass versions of this filter.

**Brick Wall:** An extremely steep filter for precise frequency cuts. There are low pass and high pass versions of this filter. This filter is great for removing just the low frequencies or high frequencies of a sound in one generator to make room for the lows or highs of another generator slot in the same track.

The New York and Tokyo filters have two parameters: Frequency Cutoff and Resonance. The Brick Wall filter only has Frequency Cutoff as a parameter. These parameters are fully modulatable via envelopes and LFOs.

**Filter Signal Path (Pre-Distortion Filter)**

In addition to the modulatable parameters for frequency cutoff and Resonance there is a check box to choose whether the filter comes before or after the Generator Effects.
GENERATOR DISTORTION

To dirty up your sounds, BreakTweaker’s Generators come fortified with an array of distortion effects. Each Generator can host two distortion effects in a serial signal flow. This means that the effect in slot 2 will further distort the signal coming from slot 1.

GENERATOR MIXING (GAIN & PAN)

Each Generator has its own set of gain and pan knobs for adjusting that Generator’s spot in the track’s mix. Gain has Envelope 1 applied to it by default. This keeps the Generator from making unwanted pops and clicks.

The Pan knob gives you the option of spreading the sounds of each Generator slot wide or keep them narrow and focused. With modulation applied each Generator slot can soar around the stereo space in different directions.
MODULATING GENERATOR LANE PARAMETERS

To bring your Generator sounds to life there are 8 sources of modulation per Generator Lane: four Low Frequency Oscillators and four Envelopes. These modulation sources can manipulate the values of parameters within a Generator Lane by moving the parameter between two values called the modulation range. First we will discuss the Modulation Knob concept and then we will get into the details of the Low Frequency Oscillators and Envelopes.

The Modulation Knob

The modulation knob is an interface to set the applied modulation source(s) and to set the range of values that the modulation source(s) can run between. If a modulation knob has no modulation sources applied to it then the knob functions like any other knob. You may turn the knob up or down to any value and it will stay at that value.

Filter Cutoff knob set to 180.0 Hz with no modulation applied

Applying LFO 1 to Filter Cutoff knob

LFO 1 applied to Filter Cutoff with a modulation start of 50 Hz and a modulation end of 1000 Hz. Double-click in the value display boxes to quickly enter an exact parameter value.

Once you apply a modulation source by clicking in one of the two modulation source pop-up menus available per knob you will be presented with the modulation range handles and both modulation range value display boxes. The modulation start value is highlighted in orange and the modulation end value is highlighted in a blue-green color.
Locked Range Handles

Double-clicking a range handle will turn the handles yellow and lock the two handles together. Now when you drag up or down on a range handle the two handles move together keeping the same range of distance between each other. Double-clicking the locked handles will unlock the handles.

The Wavetable Shape Slider

While most of the parameters in a Generator Lane come in knob form there is also one slider in the Synth Generator Type that can have modulation sources applied to it.

This is the Synth Wavetable Shape slider. The modulation slider works in a similar fashion to the modulation knob. There are two modulation source pop-up menus. When a modulation source is applied the slider handle turns into two handles which are used to control the range that the modulation source can slide across the wavetable shapes. The wavetable display also gives you a preview of the wavetable shapes that the modulation range is set to. The color of the waveform is matched to the color of the range handle. Wavetable Shape slider with no modulation sources applied.

Wavetable Shape slider with Envelope 2 applied. Notice that there are now two handles that control the range of modulation. The waveform display also shows the beginning and ending shapes that the slider will modulation between.
Contextual Menu Commands

Additional commands to manipulate the modulation knobs and sliders are accessible via the contextual menu. To access the contextual menu right-click on a modulation knob or slider. A pop-up menu will appear with various options. The last three in the menu will manipulate the applied modulation:

- **Clear Modulation** will set all applied modulation sources to none and will set the value of the knob to the modulation start value.

- **Flip Modulation** will swap the modulation start and end values.

- **Set to Full Range** will reset the modulation start and end values to their extreme values.

AHDSR Envelope

An envelope is triggered by the start of a sequencer note and is used to describe the contour of a sound. This shape is broken into a number of parameters that describe how a sound changes over time. BreakTweaker’s envelopes have five parameters: Attack, Hold, Decay, Sustain, and Release. An envelope is triggered by the start of
a sequencer note. The most common thing to apply an envelope to is the gain, or amplitude, of a Generator Lane. In fact, by default Envelope 1 in every Generator Lane is applied to output gain.

With Envelope 1 applied to the output gain of a Generator the AHDSR parameters do the following with each sequencer note that is played:

**Attack** controls the speed at which the gain is turned up in the Generator Lane. The default setting is an instantaneous 0 milliseconds. Setting the attack to 500 ms would cause the gain to ramp up to full volume over half a second (500 ms).

**Hold** controls how long the envelope will stay at the top before entering the Decay section of the envelope. This is especially useful for percussion because you might wish to hold a sound at full volume for a brief moment before decaying back down. This value is in milliseconds.

**Decay** controls the speed at which the gain falls back down to the Sustain level. This value is in milliseconds.

**Sustain** controls the level of gain to keep the Generator Lane at for the remaining duration of the sequencer note that triggered this envelope. In the picture above the sustain is set to 0.64. This means that the gain will drop to 64% of its maximum modulation range and remain (i.e. sustain) at 64% gain until the sequencer note comes to an end.

**Release** is trigger by the end of a sequencer note. Release controls the speed at which the gain is turned back down to -Infinity dB (i.e. silence). A shorter value of Release time will cause the sound to silence faster. A longer Release time will give the sound a “tail” of sound that takes some time to fade away. Long Release times mixed with many notes played in quick succession will cause the Generator’s release tails to overlap a number of times. This can cause some very loud sounds to happen as the release tails stack up. Be careful!
Making an Electronic Drum Synth

Of course Envelopes don’t have to only be applied to output gain. Try applying the following settings to a single Synth Generator Lane on a track:

Apply Envelope 1 to the Coarse Pitch knob. Set the modulation start to C0 and the modulation end to C5.

Set Envelope 1 to have an Attack of 0, Hold of 50, Decay of 500, and a Sustain of 0.

Sequence some notes in the track sequencer above the Generator Lanes and click the Preview Play button to listen to the sound of your synth drum. Try messing around with the AHDSR values in Envelope 1 and the modulation range values in the Coarse Pitch knob to see how it changes the sound of the drum synth. Next try clicking and dragging on the line segment between the Hold and Decay nodes to change the curve of envelope’s Decay.

Envelope Curves

The Attack, Decay, and Release parameters each have an additional control that sets the shape of its segment of the envelope. By clicking and dragging up or down on the line segment that goes between the Attack and Hold nodes of the envelope display you will curve the line up or down. These curves can give your modulated sound more “snap” on the attack/decay or perhaps a more gradual release tail.
Low Frequency Oscillator (LFO)

When a Low Frequency Oscillator is applied to a parameter in a Generator Lane that LFO will cause the parameter to move around in a rhythmic pattern. This pattern is decided by the waveform chosen in the LFO panel. By default the LFOs will start with the Sine Wave shape. If you drag the waveform slider to the right you will fade between some basic shapes and some more specialized, music-oriented shapes. Holding the CMD/CTRL key down while dragging will give you a more fine-tuned scrolling of the shapes.

BreakTweaker’s LFOs have the following parameters:

**Sync** (off by default): With Sync turned on the Rate value changes from a decimal value to a note division value based on the tempo of BreakTweaker. This allows you to set the LFO to cycle at musical rate such as 1/8th note or 1-bar.

**Restart** (on by default): With Restart turned on the LFO will restart its cycle each time a new note is played in the sequencer.

**Invert** (off by default): Turning Invert on will flip the polarity of the LFO. This is like flipping the LFO waveform upside down.

**Rate** controls the speed at which the LFO will cycle through its waveform. The faster the rate, the faster your parameter will move between values.

**Depth** defines how much of the modulation knob’s range the LFO will be applied to. A depth of 0.5 will cause the LFO to only traverse half of the modulation range set in the modulation range handles of the knob. This is especially useful if you wish to apply two LFOs to one modulation knob as the addition of two LFOs can create some really big modulation values. Setting both LFOs to a depth of 0.5 (50% depth) will keep those LFOs values from getting too big.

**Phase** tells the LFO where along the x-axis to start playing the LFO waveform.

**Attack** sets the amount of time the LFO takes to ramp up to its full depth.
Sample & Hold Mode

BreakTweaker’s LFOs also have a mode that will apply random values to a modulation knob. This is called Sample & Hold mode. In this mode the Rate parameter will determine how often a new random value is applied to the modulation knob. The rest of the parameters work in similar ways to the LFO Waveform mode.

Mixing Modulators

BreakTweaker’s modulation knobs and sliders have two modulation assignment slots. With two modulation sources applied the modulation is mixed in special ways depending on which types of modulation are applied. Below are some illustrations of how the modulation sources are mixed together depending on modulation type.

First, these are diagrams of the envelopes and LFO shapes used in the examples below: Two Envelopes and a Sine Wave (LFO 1) and an LFO in Sample & Hold mode (LFO 2).
Envelope + Envelope

With two envelopes applied to a modulation knob the envelope with the highest value at any given moment is the value that will be set to the knob. See the figure below for a graphical representation.

Envelope + LFO

With an envelope and an LFO applied to a modulation knob the envelope controls the amplitude of the LFO. See the figure below for a graphical representation.
LFO + LFO

With two LFOs applied to a modulation knob the two LFOs add together. Because the two LFOs are added together, in this mode it is actually possible for the modulation to go beyond the Modulation End handle. You might need to change the depth of one or both of your LFOs so the addition of the two LFOs is not as large a value. See the figure below for a graphical representation.

![Graphical representation of LFO addition](image)

LINKING ENVELOPES AND LFOs ACROSS GENERATOR LANES

Many times you wish to have the same envelope shape or LFO settings across Generator Lanes in a track. The Envelope Link and LFO Link buttons will help you accomplish this. By default, the envelopes and LFOs are not linked. For each Generator you wish to link together click the envelope or LFO link button that sits above the Modulation section of the Generator Lane. When the envelope or LFO modulators are unlinked the icon looks like this: ![Unlinked Icon]. Upon clicking the unlinked icon it will change to a linked icon: ![Linked Icon].
Once Generator Lanes are linked it does not immediately change the linked envelopes or LFOs. Only the envelope or LFO parameters that you change after linking will be updated across all the linked envelopes or LFOs. This is handy when you wish to only have the same envelope attack or LFO rate but wish to have other settings that are not shared across Generator Lanes.

**PREVIEWING YOUR TRACK’S SOUND**

To quickly preview the sound of a track’s combined Generator Lanes, press and hold the track’s sound preview button. The preview button is found in the same area as the track pan and gain knobs, at the far left.

**Generator Solo**

Each track has three generators. If you have all three generators on a track making sound simultaneously it can be hard to discern small changes to one generator. To quickly hear one generator by itself, click the Generator Solo button. If you wish to hear the one Generator Lane that you’ve solo’d by itself you will also have to solo the Track itself.

Any applied Generator Solo’s will be deactivated upon leaving the Generator view to view another track’s Generator or the full sequence. Activated Generator Solo’s will also not save with a preset.

**GENERATOR PRESETS**

To save time in re-building the same sounds over and over, BreakTweaker has Generator Presets. These save the state of a track’s three Generator Lanes. A Generator Preset can be recalled on to any track at any time. So once you have that bangin’ kick drum sound, you can save it as a Generator Preset and recall it at any time. Read more about managing and using Generator Presets in the Presets Chapter.
MicroEdit Engine

Microedits are applied to a single note in a BreakTweaker sequence. Microedits cause the Generators on that note’s track to repeat or get chopped up at a rapid rate. This is an effect similar to copying a tiny selection of audio and pasting it over and over again to create a buzzing or stuttering effect.

There are a number of parameters to define how the note’s microedit sounds. The parameters can be broken into four groups: Type, Slope, Gate, and Step Effects.

APPLYING MICROEDITS

Increasing the amount of microedits will transform the note from a slow stuttering to a high-pitched buzzing. To help you make more musical microedits there are a number of microedit modes that will let you set a microedit to a certain pitch or stutter at a tempo-synchronized rhythm.
**Microedit Modes**

**Divisions**

The default mode is to manually choose the number of divisions. This gives you free rein to set the Microedit Divisions any way you wish.

**Pitch**

Since rapid microedits create an audio-rate frequency, it is possible to set the microedits to buzz at an exact musical note. The Pitch Mode allows you to set the note value of the microedit.

**Time**

Slower-repeating microedits have a rhythmic quality to them. In Time Mode, you are able to set the microedit divisions to occur at a musical note interval such as 1/64th notes.

**Speed**

Since rapid microedits create an audio-rate frequency, it is possible to set the microedits to buzz at an exact frequency (Hz) value. If you know the exact frequency you wish to set the microedit to, choose the Hz Mode and enter in a frequency value.

**Retrigger**

With Retrigger turned on the Generators, Envelopes, and Modulation will reset and resound at the start of each microedit division. Turning Retrigger off causes the microedits to become a complex gating system. The Generators, Envelopes, and Modulation do not reset but are gated according to how the Microedit Gate section is set.

**MICROEDIT SLOPE**

There are three parameters that define how microedits are placed within a sequencer note: Shape, Tension, and Rotate.

The Shape and Tension parameters define how the microedits are distributed across the step. When Tension is 0 then the microedit divisions are distributed evenly across the step. As the Tension is applied clockwise or counter-clockwise the Shape’s algorithm skew the microedits in that direction. The microedits become grouped together in different ways depending on the type of slope. For example, the “BT Curve” shape is a logarithmic shape that causes the microedits to bunch together at
either the beginning or end of the note depending on the direction that the Tension knob is turned. This causes the sound of the microedit to speed up or slow down as the microedits become wider or narrower.

The Microedit View gives you a visual preview of how the step is going to be cut up by the microedit divisions.

Click the Microedit Preview button to hear how the microedited note play by itself.

The Rotate knob changes the phase of the microedit. In the example pictured above, the BT Curve is causing the microedits to bunch up to the left. By turning the Rotate knob the microedits will slide to the right and the widest microedits will wrap around to the beginning of the note. In the picture below you can see how the microedits have rotated around.

Musical Shapes

These shapes are designed to turn your microedits into musical scales and riffs. For example, the Octave shape will take the base microedit division and play it at its normal speed for the first half of the note and then switch to twice as fast (i.e. an octave up) for the second half of the note. The 1-4-5 shape will divide the microedits into three regions playing first at the speed designated by the Microedit Amount, then up a fourth, then up a fifth. The Tension and Rotate knobs will push the distribution of these microedits around.
MICROEDIT GATE

The Gate section allows you to cut out space between each Microedit Division. There are three parameters you can set: Amount, Spread, and Tail.

The Gate Amount defines how much of the microedit will be turned into silence. With Amount set to 0% each microedit will be its full amount with no space between each Division. At 90% each Microedit Division will be cut down to 10% sound and 90% silence.

The Gate Spread scales the gate amount over time across a note.

The Microedit Tail smooths out the gate. Instead of transitioning immediately from microedit sound to silence the Tail will fade the sound to silence. This will smooth out the buzzing effect of microedits. The Tail is illustrated in the microedit view as the darker blue rectangles that are to the right of each light blue division.

COARSE PITCH OFFSET

The Coarse Pitch Offset allows you to detune the combined Synth and One Shot Generator Lanes of a track at each note in the track’s sequencer. This allows for creating simple bass lines or pitch modulated sounds. For example, one could set the Synth Generator to sound at “B1”. Then at each note you wish to be transposed up or down to another note, change the Coarse Pitch Offset of that step. This way you could have one note at the root note (Coarse Pitch Offset: 0) and another note up a third (Coarse Pitch Offset: +3).

MICROEDIT STEP FADES AND EFFECTS

To add to the sound design possibilities each step can have two additional adjustments applied to it: one Step Fade and one Step Effect.
Step Fade

The **Step Fade** applies a volume fade up or down curve to your step. This is especially useful when you have microedit divisions applied to a step. This Step Fade will gently fade in or out the microedited sound.

Step Effect

Each step can have one of six audio effects applied to it. There are two knobs to control the settings of each effect. The knobs control different settings depending on the selected effect. The included effects are Digital distortion, Raw distortion, Aliasing distortion, Chorus, Low Pass Tokyo Filter, and High Pass Tokyo Filter.
Multi-channel Output in your DAW

In most Digital Audio Workstations (DAW) BreakTweaker has the ability to send each of its individual tracks to separate outputs within your DAW. On the far right edge of the BreakTweaker interface are pop-up menus that line up with each track. These track output menus, by default, are set to the master stereo output of BreakTweaker which is indicated by the “M” in the menu. In these pop-up menus you may choose an alternate set of stereo outputs for each track. When an alternate output channel is chosen for a track that track will no longer be output to the master output of BreakTweaker. These auxiliary outputs can then be routed to their own tracks in your DAW where you can mix and mangle the individual tracks any way you wish.

On the next few pages are basic instructions for setting up multi-channel output within popular DAWs.
ABLETON LIVE

1. Insert BreakTweaker on a MIDI track.
2. Create one to six new Audio tracks to receive the BreakTweaker audio.
3. Turn on the I/O display to view the input/output assignments.
4. Set the Audio From menu to the instance of iZotope BreakTweaker (1-iZotope BreakTweaker).
5. Set the next menu down to the BreakTweaker track output you wish to receive on this track. The track numbers are offset by 1 number, so Track 1 in BreakTweaker is listed as 2-iZotope BreakTweaker.
6. Set the Monitor mode to “In”.
7. Set BreakTweaker’s track outputs to the configuration you wish to have. You may have each track output to its own DAW track or combine multiple tracks in BreakTweaker into one track in your DAW.

PRO TOOLS 10

1. Insert the iZotope BreakTweaker Multi-Out version of the RTAS plug-in on an Instrument Track
2. Insert stereo Aux tracks to receive each auxiliary out from BreakTweaker
3. In each of the Aux tracks set the Audio Input Path menu to Plug-In > iZotope > iZotope BreakTweaker Multi-Out - <track name> > Aux #
4. Set BreakTweaker’s track outputs to the configuration you wish to have. You may have each track output to its own DAW track or combine multiple tracks in BreakTweaker into one track in your DAW.

PRO TOOLS 11

1. Insert the iZotope BreakTweaker AAX plug-in on an Instrument Track
2. Insert stereo Aux tracks to receive each auxiliary out from BreakTweaker
3. In each of the Aux tracks set the Audio Input Path menu to Plug-In > iZotope > iZotope BreakTweaker Multi-Out - <track name> > Aux #
4. Set BreakTweaker’s track outputs to the configuration you wish to have. You may have each track output to its own DAW track or combine multiple tracks in BreakTweaker into one track in your DAW.
APPLE LOGIC PRO X
1. Insert the Multi Output version of BreakTweaker on a software instrument track.
2. View the mixer in Logic X by clicking View > Show Mixer.
3. Within the mixer view, look for the (+) button above the solo button on BreakTweaker’s track. Press the (+) button six times. This will add all 6 BreakTweaker tracks automatically.
4. Set BreakTweaker’s track outputs to the configuration you wish to have. You may have each track output to its own DAW track or combine multiple tracks in BreakTweaker into one track in your DAW.

IMAGELINE FL STUDIO
1. Insert BreakTweaker VST into your project
2. Click the Wrapping settings button in the upper left corner of the BreakTweaker VST window.
3. Click the Processing tab.
4. Press the Auto map outputs button to automatically route BreakTweaker’s auxiliary outputs to Inserts in FL Studio’s Mixer.
5. Set BreakTweaker’s track outputs to the configuration you wish to have. You may have each track output to its own DAW track or combine multiple tracks in BreakTweaker into one track in your DAW.

STEINBERG NUENDO/CUBASE
1. To insert BreakTweaker go to the Devices > VST Instruments menu
2. Click on one of the “no instrument” empty slots and choose iZotope BreakTweaker from the list of instruments
3. After BreakTweaker instantiates go back to the VST Instruments window and click small gray icon (elenium) directly to the left of where it lists iZotope BreakTweaker.
4. Click Activate All Outputs from the pop-up menu.
5. Set BreakTweaker’s track outputs to the configuration you wish to have. You may have each track output to its own DAW track or combine multiple tracks in BreakTweaker into one track in your DAW.
DIGITAL PERFORMER
1. Insert a BreakTweaker into your project via the menu Project > Add Track > Instrument Track > iZotope > BreakTweaker (stereo)
2. Create one to six new Aux Tracks to receive the BreakTweaker audio.
3. In the Mixing Board view set the Aux Tracks to the multi-out stereo bundles from your instance of BreakTweaker. BreakTweaker’s auxiliary output stereo bundles start with channels 3-4.
4. Set BreakTweaker’s track outputs to the configuration you wish to have. You may have each track output to its own DAW track or combine multiple tracks in BreakTweaker into one track in your DAW.

COCKOS REAPER
1. Insert a new software instrument track in your project.
2. Choose iZotope BreakTweaker from the list of available instruments.
3. Reaper will ask you if you would like to create tracks for all the outputs available from BreakTweaker. Click Yes. Clicking No will create a stereo instance of BreakTweaker.
4. Set BreakTweaker’s track outputs to the configuration you wish to have. You may have each track output to its own DAW track or combine multiple tracks in BreakTweaker into one track in your DAW.

SONAR X2/X3
1. Insert > Soft Synth > Vstplugins > iZotope BreakTweaker.
2. Create one to six new Audio Tracks to receive the BreakTweaker audio.
3. Go to the Tracks menu in your project and choose Selected Track Inputs…
4. Choose one of the Audio Tracks you created from the list and click the Audio Inputs pop-up menu. A list of options will show up including items that start with “iZotope BreakTweaker”. Generally you will want to choose one of the stereo options that are available. The track numbering is offset by 1. This means that in BreakTweaker, track output 1 will be listed as 2.
5. Set BreakTweaker’s track outputs to the configuration you wish to have. You may have each track output to its own DAW track or combine multiple tracks in BreakTweaker into one track in your DAW.
How to purchase the full version of BreakTweaker

If you are using the demo version of BreakTweaker and would like the full version, you can purchase BreakTweaker direct from the iZotope online store: http://www.izotope.com/BreakTweaker

Once your purchase is complete you will be sent an e-mail confirmation and a full version serial number that can be used to fully authorize your current installation of BreakTweaker.

iZotope Customer Support Policy

iZotope is happy to provide professional technical customer support to all registered users. We also offer valuable pre-sales support to customers who may be interested in purchasing an iZotope product.

For details, please see our Product Support Policy.

Before contacting iZotope's Customer Care team, you can search our Product Knowledgebase to see if the solution to your problem has already been published.

How to contact iZotope for Technical Support

For additional help with BreakTweaker, please check out the support pages on our web site at http://www.izotope.com/support or contact our customer support department at support@izotope.com.

iZotope's highly trained support team is committed to responding to all requests within one (1) business day and frequently respond faster. Please try to explain your problem with as much detail and clarity as possible. This will ensure our ability to solve your problem accurately, the first time around. Please include all system specs and the build/version of BreakTweaker that you are using.

Once your support request is submitted, you should automatically receive a confirmation email from iZotope support. If you do not receive this email within a few minutes please check your spam folder and make sure our responses are not getting blocked. To prevent this from happening please add support@izotope.com to your list of allowed email addresses.

International Distribution

Support is also available from our international distributors worldwide, for any customers who purchased their iZotope products through a certified iZotope distributor. Check with your local distributor for their availability. If you would like help locating your local distributor please contact iZotope support: http://www.izotope.com/support.